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Introduction

The Krokodile Cartridge is a programmable game cartridge for the Atari 
2600 game console. The cartridge contains 512K of Flash ROM that 
can be programmed by connecting the cartridge to a Windows PC with 
a serial cable. Once connected to a PC, the Windows-based Krokodile 
Commander software is then used to download 2600 ROMs into the 
Krokodile Cartridge. The cartridge also includes 32K of built-in RAM to 
support games that require additional onboard cartridge memory (such 
as Atari’s SARA-chip games).

Using the provided Krokodile Commander software for Windows, you 
can directly download Atari 2600 ROM images to the cartridge. In 
addition to downloading a single ROM binary, the cartridge can also 
be used as a multicart. It can store up to 127 games (4K) which can 
be selected with a built-in menu system. Bankswitched multicarts are 
also supported, allowing you to create F8 (8K), F6 (16K) and F4 (32K) 
bankswitched multicarts. The multicarts can be created with the included 
Krokodile Commander software. You can easily select which games you 
want to have on the cartridge and once you’ve made your selections you 
can download the created multicart image to the Krokodile Cartridge. 

The Krokodile Commander can also be invoked on the command-
line, which makes it possible to automatically download a binary to the 
cartridge after your compile has completed. Additionally, there is an 
“incremental download” mode that will “patch” the binary in the cartridge, 
only downloading the differences between the new binary and the binary 
currently in the cartridge.

The Krokodile Cartridge supports the following bankswitching modes: 

• 1K / 2K / 4K (Non-Bankswitched) 

• F8 (Atari 'Standard' 8K) / F8 SARA Chip 

• F6 (Atari 'Standard' 16K) / F6 SARA Chip 

• F4 (Atari 'Standard' 32K) / F4 SARA Chip 

• 3F (Tigervision, up to 512K ROM) 
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• 3E (up to 512K ROM and 32K RAM) 

• EF (64K) 

• FA (CBS RAM+ cartridges) 

• UA (UA Limited - Pleiades & Funky Fish) 

• CV (CommaVid)

• E7 (M-Network) (Firmware Revision 1.1+)

• 0840 (8K EconoBanking)

The following Multicart modes are also supported: 

• 1K / 2K / 4K Multicart (127 Games) 

• F8 (8K) Multicart (63 Games) 

• F6 (16K) Multicart (31 Games) 

• F4 (32K) Multicart (15 Games)

The Krokodile Cartridge includes the cartridge, this manual, a serial 
cable, and the Krokodile Commander software on CD. The power supply 
is not included.

Serial Cable

Use the serial cable to connect the Krokodile Cartridge to your computer. 
The female connector must be plugged into your computer and the male 
connector must be plugged into the Krokodile Cartridge.

Power Supply

The Krokodile Cartridge requires a power supply with a voltage between 
+6V and +9V DC and at least 500mA. An Atari 2600 power supply can 
be used. The power connector is 3.5 mm and has exactly the same 
dimensions and polarity as the connector of the 2600. Make sure that 
the polarity of the connector is as follows: the tip is positive and the back 
part of the connector is connected to ground. Do not swap the polarity, 
because you could damage your Krokodile Cartridge.

5



To program the Krokodile Cartridge, unplug it from the 2600 and connect 
it to an external power supply as well as to your computer with the 
supplied serial cable. After programming, disconnect the external power 
supply as well as the serial cable and plug the cartridge into your 2600.

Once the Krokodile Cartridge has been programmed, it can be plugged 
directly into the Atari 2600 like any other game cartridge. You must not 
program the Krokodile Cartridge while it is plugged into the 2600. 
Always unplug the Krokodile Cartridge from your 2600 when you 
program it, or you could damage your 2600.

Using the Krokodile Cartridge

Your Atari 2600 must be switched off when you insert the Krokodile 
Cartridge into the cartridge slot. Never insert the Krokodile Cartridge 
into your Atari 2600 with the power on. This could damage both your 
Krokodile Cartridge and your 2600. 

After inserting the Krokodile Cartridge, turn on the 2600. Now your 
Krokodile Cartridge should behave as the ROM you have downloaded. 

The Krokodile Commander

The Krokodile Commander software is located on the CD included with 
your package and allows you to download software to your Krokodile 
Cartridge. You can copy the “Krokodile Commander” directory containing 
the Krokodile Commander software to your hard disk and then make a 
shortcut in your Start menu or desktop to access it quickly. To start the 
Krokodile Commander, double-click on the “Krokodile Commander.exe” file.

To run the Krokodile Commander on Windows 98, you have to 
install Microsoft Jet 4.0 Service Pack 8. The name of the package is 
“Jet40SP8_9xNT.exe” and is located on the CD.
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The Krokodile Commander has three tabs:  ROM, Database and 
Multicart. In addition, there is a menu and a status bar. Next to the status 
bar, there is an LED graphic which indicates the status of the Krokodile 
Cartridge.

When the Krokodile Commander is started, it tries to connect to the 
Krokodile Cartridge. The Commander will search for the cart on serial 
ports COM1 to COM5. If the cartridge can be found, the firmware 
revision and the COM port are displayed in the status bar. The LED will 
turn green to indicate the Krokodile Cartridge has been found.
If (at startup of the Commander) your computer is not connected to the 
Krokodile Cartridge, or the Krokodile Cartridge is not powered, the LED 
turns to red and the message “Device Not Found” is displayed in the 
status bar.

You can try to connect to the Krokodile Cartridge at any time, by 
using the command “Connect” from the “Device” menu. If you attempt 
any operations with the cartridge, like downloading or verifying, the 
Commander automatically connects to the cartridge.

The ROM Tab

The ROM Tab is used to program the Krokodile Cartridge.

7

Kroko Manual.indd   15 10/5/07   1:08:37 PM



Selecting and Downloading ROM Files

The edit box “ROM File” shows the currently selected 2600 ROM image. 
This is the ROM which will be downloaded to the cartridge. To transfer 
the ROM to the Krokodile Cartridge, press the “Download” button. You 
can also download a ROM by selecting “Download ROM” from the “File” 
menu. 

The file path can either be manually typed in or a binary from the local 
hard drive can be selected by clicking on the button to the right of the 
“ROM File” edit box. You can also choose “Select ROM” from the “File” 
menu. You may also use “Drag and Drop” to drop a ROM image from the 
Windows Explorer onto the ROM tab of the Krokodile Commander. The 
size of the selected ROM file is displayed in the “ROM Size” information 
box. 

While downloading to the Krokodile Cartridge, a progress bar shows how 
much of the ROM image has been transferred to the cartridge. 

If there are transmission errors when the Krokodile Commander tries to 
communicate with the Krokodile Cartridge, you can define how often the 
Commander should retry sending a command to the cartridge before it 
displays a transmission error. Choose the “Retry Count” in the “Options” 
menu.

There is a feature called “Auto download after file select” which can be 
activated in the “Options” menu. If this feature is activated, the ROM file 
will immediately be transferred to the cartridge after you have selected 
the file. 

Bankswitching Modes

The downloaded ROM will only work if the correct bankswitching mode 
was chosen in the “Bankswitching” drop-down list. Most 2600 ROM 
files are registered in the database that comes with the Krokodile 
Commander. When you choose a binary from your drive, the correct 
bankswitching mode will be chosen automatically, as long as you have 
selected a ROM that is already in the database. 
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If an unknown ROM is selected, the Krokodile Commander will make a 
new entry in its database. Your selection from the “Bankswitching” drop-
down list is automatically stored to the database. Next time the same 
ROM is selected, the bankswitching mode will be chosen automatically. 
You can enter more details to describe the selected ROM file on the 
Krokodile Commander’s Database tab.

Note! If the bankswitching mode of a known ROM is manually changed, 
this change is stored to the database and will be the new default if the 
same ROM is selected again in the future.

The bankswitching modes F0, E0, FE and AR are NOT supported by 
the Krokodile Cartridge. You can select and download ROMs with these 
modes to the Krokodile Cartridge, but they will not run on the 2600.

Verify

To check if the content of the Krokodile Cartridge and the file that is 
selected in the “ROM File” edit box are the same, you can press the 
“Verify” button. You can also start verifying by selecting “Verify ROM” 
from the “File” menu. 

You can verify at any time, but it makes sense to do it directly after you 
have programmed the device. If the contents of the cartridge do not 
match the selected ROM, an error message is displayed in the status 
bar. Try to repeat the download until the verify is successful.

It is not very likely that you will get errors when downloading. For this 
reason, you are not forced to do a verify after you download a ROM. 
If you want to make sure that your ROMs are always successfully 
transferred, you can activate the feature “Auto verify after download” 
from the “Options“ menu. The Krokodile Commander will then always do 
a verify after a download to the device has been completed.

Do not verify the ROM image while your game is running on the 2600. 
If you attempt to verify the ROM after you have started your game, your 
game will crash.
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Incremental Downloading
 
The Krokodile Commander keeps track of what is currently programmed 
on the Krokodile Cartridge. If you activate the feature “Incremental 
Download”, the Krokodile Commander will only transfer those parts of 
the ROM that are different from what is already programmed into the 
Krokodile Cartridge.

This allows for extremely fast downloading, especially if the binary 
has only changed little, which is often the case during development of 
homebrew games or if you add just one more game to a multicart.

Recent Files List

The “File” menu contains a recent files list, which shows the last 
six ROMs that have been selected with the file select button on the 
ROM tab. If one of the entries is selected, the corresponding ROM is 
immediately downloaded to the cartridge.

Quick Pick

There is a field of sixteen “Quick Pick” buttons. Each button can be 
assigned to one of your favorite ROM files. To assign a ROM to a button, 
right click the button and select the file in the displayed file dialog. Left 
click the button to download the ROM to the Krokodile Cartridge.

The Database Tab

The Database Tab is used to show and enter information about the ROM 
Image that is currently selected in the ROM tab. 

To uniquely identify a ROM, the Krokodile Commander calculates its 
MD5 hash, which is displayed in the MD5 info box. No two different 
ROMs will ever have the same MD5 hash. This hash is used as the 
primary key for the Krokodile Database, which holds information about 
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2600 ROMs. The same MD5 hash is used by 2600 emulators to identify 
known ROMs. This allows a ROM to be identified by the Krokodile 
Commander even if the filename changes.

In the Krokodile database, the following information is stored about each 
ROM:

•Name of the ROM
•Manufacturer
•MD5
•Model No.
•Rarity
•Cartridge Type (Bankswitching Mode)
•Display Format
•Left and Right Controller (Paddle, Joystick, etc.)
•Note (A comment about the game / ROM)

The above information can be entered in the Database tab. To store 
your changes to the database choose “Write Info to Database” from the 
“Database” menu.

Importing .PRO Files

All of the above information that can be stored in the Krokodile database 
is also found in the “.PRO” files of the Stella Atari 2600 emulator. If you 
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want to update the information that is stored in the Krokodile Database 
with the latest version of the stella.pro file, choose “Import .PRO File” 
from the “Database” menu.

After you have selected the .PRO file, an Import dialog will open to show 
the current import status and to show what is currently done.
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This dialog will lead you through the import process. If an entry is 
detected in the .PRO file which would change information that is already 
stored in the Krokodile database, the import process will pause, allowing 
you to decide how to proceed.

The Multicart Tab

The Multicart Tab is used to create a collection of 2600 ROMs. This 
collection can be used to create a 2600 multicart ROM, which you can 
download to the Krokodile Cartridge.

To create a new multicart collection, press the “New” button. In the 
“Type” drop-down list, you can choose the multicart type. There are four 
possible multicart types: 4K, F8 (8K), F6 (16K) and F4 (32K).

The type defines the bankswitching mode of the multicart. All games on a 
multicart must have the same bankswitching mode. If, for example, an F8 
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multicart is created, all games on the cart have to be F8 bankswitched. 
ROMs that are not bankswitched (1K/2K/4K) can be loaded into 
any multicart type. But it is not possible to mix ROMs with different 
bankswitch types (for instance, F8 and F6).

The Krokodile Commander can store all selections on the Multicart tab 
in an Info File. The path of this file must be entered in the “Multicart Info” 
edit box. To store the selections on the Multicart tab, press the “Save” 
button. Info Files have the default extension “.MUL”.

To delete the Info File that is currently selected in the “Multicart Info” edit 
box from your hard drive, press the “Delete” button (represented by a 
trash can).

The “Select” button is used to load a previously stored Multicart Info file.

The grid in the center of the Multicart tab is used to select the ROM files 
which should be part of the multicart. With the “Select” button (in each 
grid row), a binary can be chosen from your hard drive. The “Delete” 
button in each grid row clears the entry in the corresponding grid row. 
After a file is selected, the Krokodile Commander auto generates a 
suggestion for its multicart menu entry. This suggestion is filled into the 
“Menu Name” column. The menu name will be shown in the multicart’s 
menu system when you power up the cartridge in a 2600. The maximum 
length of the menu name is 13 characters. The number in the “Pos” 
column shows the order of the entries in the multicart menu. To move a 
ROM to a different position, select the ROM in the grid and use the “Up” 
and “Down” buttons to move it to a different location.

The “Bulk Load” button can be used to load all ROMs from a directory 
into the multicart grid. After the button is pressed, you must then choose 
a directory to load files from. All files which can be downloaded to a 
multicart of the chosen type are then loaded into the grid, starting from 
the first available slot until the multicart grid is full.

You can use “Drag and Drop” to choose ROM files for the multicart grid. 
Using the Windows Explorer, select all files you wish to include in your 
multicart, then drag and drop them into the multicart grid. Make sure to 
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select the position in the multicart grid where you want to insert the files 
before you drop them.

Before a multicart ROM can be created, a filename has to be chosen 
in the “Create Multi-Rom” edit box. This will be the binary that can be 
downloaded to the Krokodile Cartridge. After a multicart is downloaded to 
the Krokodile Cartridge, you’ll see a menu system displaying the names of 
the ROMs in the multicart when you power up the cartridge in a 2600. With 
the “PAL / NTSC” radio buttons in the lower right corner of the Multicart 
tab, you can decide if the menu should start in PAL or NTSC mode. 

When you press the “Create” button, the multicart image is registered 
in the Krokodile database. In addition, the created multicart image 
is automatically selected in the Commander’s ROM tab. The correct 
bankswitching mode is also auto selected. At this point, all you need to 
do is press the “Download” button on the ROM tab to load the multicart 
into the Krokodile Cartridge.

The Multicart Menu

If you have programmed a multicart image to your Krokodile Cartridge, 
the 2600 will show a menu system. If you cycle the TV-Type switch, you 
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can change the menu’s video mode from PAL to NTSC and vice versa.
To start the game that is marked by the menu-bar, press the joystick or 
paddle button or hold down the Game Reset switch on your console. 
The bar can be moved up and down with a joystick or paddle plugged 
into the left controller port. Move left and right with the joystick to move 
up and down through the list of games, one page at a time. You can also 
move the selection bar down by holding down the Game Select switch on 
your console. The driving controller is also supported to select games. 
 

Batch Mode

The Krokodile Commander can also be used from a batch job. If you 
invoke the Krokodile Commander software with parameters, the user 
interface will not be displayed and instead the Krokodile Commander will 
execute any commands specified on the command line. 

Example:

“Krokodile Commander.exe” hs_2600.bin -av -id -bs=F6

The first parameter is the complete filename of the ROM file. After the 
ROM you can specify several options:

• av – Auto Verify
• id – Incremental Download
• bs –Bankswitching Mode

You can specify the following bankswitching modes:

4K,2K,1K,MC,F8,F8SC,MCF8,F6,F6SC,MCF6,F4,F4SC,MCF4,EF,
3F,3E,FA,FASC,CV,UA,E7,0840 

Troubleshooting

If you have problems with your Krokodile Cart, try the following:
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 • Deactivate incremental downloading and repeat the download. 
 • After the download, do a verify to make sure that the transmission  
 • was successful.
 • Clean the cartridge connector with alcohol and a cotton swab.
 • Try to use a power supply with a rating of at least 500mA.
 • Some Atari 2600 power supplies only deliver a rating of 400mA.
 • Try using a different power supply with the Krokodile Cartridge.

If these troubleshooting tips do not help, you may contact me via e-mail: 
armin.vogl@gmx.net
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Warranty

The Krokodile Cartridge is guaranteed for 90 days against defects in 
materials or workmanship. We cannot be responsible for any damage 
due to improper use of the Krokodile Cartridge. All software distributed 
with the Krokodile Cartridge is provided “AS-IS” with no warranty of any 
kind.
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